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Abstract

These Application Notes describe the procedure for configuring Intermedia Session Initiation
Protocol (SIP) Trunking using TLS/SRTP with Avaya IP Office.

Intermedia SIP Trunking provides PSTN access via a SIP trunk between the enterprise and
Intermedia as an alternative to legacy analog or digital trunks. This approach generally results
in lower cost for the enterprise.

Readers should pay attention to Section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.

Intermedia is a member of the Avaya DevConnect Service Provider program. Information in
these Application Notes has been obtained through DevConnect compliance testing and
additional technical discussions. Testing was conducted via the DevConnect Program at the
Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the procedure for configuring Session Initiation Protocol (SIP)
Trunking using TLS/SRTP between service provider Intermedia and an Avaya IP Office solution. In
the sample configuration, the Avaya IP Office solution consists of an Avaya IP Office Server Edition
Release 10, Avaya Voicemail Pro, Avaya IP Office Softphone, and Avaya H.323, SIP, digital, and
analog endpoints.

The Intermedia SIP Trunking service referenced within these Application Notes is designed for
business customers. The service enables local and long distance PSTN calls via standards-based SIP
trunks as an alternative to legacy analog or digital trunks, without the need for additional TDM
enterprise gateways and the associated maintenance costs.

2. General Test Approach and Test Results

The general test approach was to configure a simulated enterprise site using Avaya IP Office to
connect to Intermedia SIP Trunking service using SIP trunk via TLS/SRTP. This configuration
(shown in Figure 1) was used to exercise the features and functionality tests listed in Section 2.1.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent to
the interoperability of the tested products and their functionalities. DevConnect Compliance Testing
is not intended to substitute full product performance or feature testing performed by DevConnect
members, nor is it to be construed as an endorsement by Avaya of the suitability or completeness of
a DevConnect member’s solution.

2.1. Interoperability Compliance Testing
A simulated enterprise site with Avaya IP Office was connected to Intermedia SIP Trunking service

via SIP trunk using TLS/SRTP. To verify SIP trunking interoperability, the following features and
functionality were exercised during the interoperability compliance test:

e Response to SIP OPTIONS queries.

e SIP registration.

e Incoming PSTN calls to various phone types. Phone types included H.323, SIP, digital, and
analog telephones at the enterprise. All inbound PSTN calls were routed to the enterprise
across the SIP trunk from the service provider.

e Outgoing PSTN calls from various phone types. Phone types included H.323, SIP, digital,
and analog telephones at the enterprise. All outbound PSTN calls were routed from the
enterprise across the SIP trunk to the service provider.

e Inbound and outbound PSTN calls to/from the Avaya IP Office Softphone.

e Inbound and outbound long holding time call stability.

e Various call types including: local, long distance, international, outbound toll-free, operator
service and directory assistance.

e Codec G.711mu-law and G.729.

e Caller number/ID presentation.
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e Privacy requests (i.e., caller anonymity) and Caller ID restriction for inbound and outbound
calls.

e DTMF transmission using RFC 2833.

e Voicemail navigation for inbound and outbound calls.

Telephony features such as hold and resume, transfer, and conference.

Fax G.711 mode.

Off-net call forwarding.

Twinning to mobile phones on inbound calls.

Avaya Communicator for Web Client (WebRTC).

Note: Avaya Communicator for Web client (WebRTC) was tested as part of this solution. The
configuration necessary to support Avaya Communicator for Web client is beyond the scope of these
Application Notes and is not included in these Application Notes. For these configuration details, see
Reference [5.

2.2. Test Results
Intermedia SIP Trunking passed compliance testing.

Items not supported or not tested included the following:

Inbound toll-free is supported but was not tested as part of the compliance test.
Call Redirection using SIP REFER method is not supported.

SIP OPTIONS sent by Intermedia is not supported.

Intermedia does not support SIP Diversion header.

Operator Call (dial 0) and Operator Assisted (dial 0+10digits) are not supported.
Fax T.38 is not supported.

Interoperability testing of Intermedia SIP Trunking was completed with successful results for all test
cases with the exception of the observations/limitations described below.

e SIP OPTIONS - Intermedia did not to send SIP OPTIONS but responded to SIP OPTIONS.
e TLS Hand-Shaking — Intermedia acted as a server and client (IP Office) did not need to
authenticate with the server.

2.3. Support

For technical support on the Avaya products described in these Application Notes visit
http://support.avaya.com.

For technical support on Intermedia SIP Trunking, contact Intermedia at
http://www.intermedia.net/products/sip-trunking
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3. Reference Configuration

Figure 1 below illustrates the test configuration. The test configuration shows an enterprise site
connected to Intermedia SIP Trunking service public IP network. For confidentiality and privacy
purposes, actual public IP addresses used in this testing have been masked out and replaced with
fictitious IP addresses throughout the document.

Located at the enterprise site is an Avaya IP Office Server Edition with the MOD DGTL STA16
expansion which provides connections for 16 digital stations to the PSTN, the extension PHONE 8
card which provides connections for 8 analog stations to the PSTN as well as 64-channel VCM
(Voice Compression Module) for supporting VVolP codecs. The LAN port of Avaya IP Office is
connected to the enterprise LAN while the WAN port is connected to the public IP network.
Endpoints include an Avaya 9600 Series IP Telephone (with H.323 firmware), an Avaya 9508
Digital Telephone, an Avaya Symphony 2000 Analog Telephone, Avaya 1100 Series SIP
Deskphone and Avaya Communicator. A separate Windows PC runs Avaya IP Office Manager to
configure and administer Avaya IP Office.

Mobility Twinning is configured for some of the Avaya IP Office users so that calls to these user
phones will also ring and can be answered at the configured mobile phones.

PSTN Phone@as
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192.168.122.44

Internet

Avaya IP Office Server

AN IR e TR,

10.10.97.61 i

SIPITLS |

WAN |
Avaya Voicemail Pro
| for IP Office
2 < . Avaya 11x0 SIP 10.10.98.86
3 Avaya Communicator ~ Avaya 9600-Series
Avaya IP Office 10.10.97. 29 for‘{“ndows H.323IP Telaphona P Telephone
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Figure 1: Test Configuration for Avaya IP Office with Intermedia SIP Trunking Service
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For the purposes of the compliance test, Avaya IP Office users dialed a short code of 7 + N digits to
send digits across the SIP trunk to Intermedia. The short code of 7 was stripped off by Avaya IP
Office but the remaining N digits were sent unaltered to Intermedia. For calls within the North
American Numbering Plan (NANP), the user would dial 11 (1 + 10) digits. Thus for these NANP
calls, Avaya IP Office would send 11 digits in the Request URI and the To field of an outbound SIP
INVITE message. It was configured to send 10 digits in the From field. For inbound calls,
Intermedia SIP Trunking sent 11 (starting with digit 1) digits in the Request URI and the To field of
inbound SIP INVITE messages.

4. Equipment and Software Validated
The following equipment and software/firmware were used for the sample configuration provided:

Avaya Telephony Components

Equipment Release
Avaya IP Office Server Edition 10.0.0.0.0 build 550
Avaya IP Office 500v2 (Expansion) 10.0.0.0.0 build 550
Avaya IP Office Manager 10.0.0.0.0 build 550
Avaya Voicemail Pro for IP Office 10.0.0.0.0 build 550
Avaya 11x0 IP Telephone (SIP) SIP11x0e04.04.23.00
Avaya 9621G IP Telephone (H.323) 6.6.2.29.050316
Avaya Communicator for Windows 2.0.3.237
Avaya Communicator for Web (WebRTC) 1.0.16.1718
Avaya Digital Telephone (9508) 0.45
Avaya Symphony 2000 Analog Telephone N/A

Intermedia SIP Trunking Service Components

Component Release
Intermedia SBC 16.14.8
Intermedia Softswitch 16.14.8

Note: Compliance Testing is applicable when the tested solution is deployed with a standalone IP
Office 500 V2 and also when deployed with all configurations of IP Office Server Edition without
T.38 Fax Service.
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5. Configure IP Office

This section describes IP Office configuration to support connectivity to Intermedia SIP Trunking
service. IP Office is configured through IP Office Manager PC application. From a PC running IP
Office Manager application, select Start - Programs - IP Office > Manager to launch the
application. Navigate to File > Open Configuration, select the proper IP Office system from the
pop-up window, and log in with the appropriate credentials. A management window will appear
similar to the one shown in the next section. The appearance of the IP Office Manager can be
customized using the View menu. In the screens presented in this section, the View menu was
configured to show the Navigation pane on the left side, the Group pane in the center, and the
Details pane on the right side. These panes will be referenced throughout IP Office configuration.
Proper licensing as well as standard feature configurations that are not directly related to the
interface with the service provider (such as LAN interface to the enterprise site and IP Office
Softphone support) is assumed to be already in place.

5.1. LAN Settings

In the sample configuration, the DevCon IPO2 was used as the system name and the WAN port was
used to connect IP Office to the public network. The LAN2 settings correspond to the WAN port on
IP Office.

To access the LAN settings, first navigate to System (1) - DevCon IPO2 in the Navigation and
Group Panes and then navigate to the LAN2 - LAN Settings tab in the Details Pane.

e Setthe IP Address field to the IP address assigned to the Avaya IP Office WAN port.

e Setthe IP Mask field to the mask used on the public network.

e All other parameters should be set according to customer requirements.

e Click OK.

Configuration ‘E? SEQTVM* = A AREE

#-& BOOTP (8)

- VolP Security Contact Center
H-47% Operator (3)

=% Solution Systern LAN1  LAN2Z  DNS Voicemail Telephony Directory Services  System Events  SMTP SMDR - VilP
+: User(30) LAN Settings  VolP Network Topology
+ﬂ Group(l)
+-@% Short Code(45) IP Address 10 10 97 61
-85 Directory(0)
£ Time Profile(0) IP Mask 255 . 255 . 25F . 240

----- @ Account Code(0)
+-§3 User Rights(9)

88 Location(0 -
% Location(0) Number Of DHCP IP Addresses 200 =

= -5 SEQT VM
-5 System (1) DHCP Mode
547 Line ) O Server O Client @ Disabled fevenced

-2 Control Unit (8)
-4 Extension ()
§ User (7 Help
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Select the Vol P tab as shown in the following screen.

e The H323 Gatekeeper Enable box is checked to allow the use of Avaya IP Telephones
using the H.323 protocol, such the 9600-Series IP Telephones used in the sample
configuration.

e The SIP Trunks Enable box must be checked to enable the configuration of SIP trunks to
service provider.

e The SIP Registrar Enable box is checked to allow IP Office Soft-phone usage.

e The Layer 4 Protocol, check the UDP, TCP and TLS boxes. Then set UDP and TCP Ports
to 5060, and TLS port to 5061.

e All other parameters should be set according to customer requirements.

e Click OK.

Configuration |E: SEQTVM" o -3 X v
7 R BOOTP @) p ~ N2 N R g St e | .
. A System LANT LANZ  DNS Vocemall  Telepheey Oirectory Services  Spstem Events  SMTP  SMOR  VolP volP Security  Contact Center
- Opesator (3)
¥ Solution LAN Settings Vol®  Network Topology
i User(30) ~
+ 0B Groupll) 1 HM323 Gatekeeper Ensble
# 9% Shot Codels3) "] Auto-create Extenzion Auta-create Use [[] H323 Remote Etension Enable
# Directory(0)
L Time Profileit) M.323 Signafing over TLS Dviabiled
& Account Codell & .
' l 4 User Rights(d)
i Location(l) B2 SIP Trunks Enable
- EaTVM 2
~ S.":t:m m ] SIP Regrstrar Ensble
o SQTVM | Aute.create Extencion/ Uses "] 5P Remnote Extension Enable
£ 14 Line ()
Control Unst (5) 59 Domain Name
i & Extenzion {6)
v e SP Regetrar FCON
& Group (2
i, #% Short Code (50) &2 voe UDe Port | %060 2
@ Senwce @
+ @ Incoming Call Reaste {8) | Layer 4 Protocol M cp TCP Port 5080 %
o Directory (0) 200 — .
Time Profile (T TS TL5Port 3081 -
+ I P Roate (1) ; ;
& Account Code (0) Chatienge Expiration Tame (sec) 0
W License (30)
+ B User Righas (9 TP
v ARS () 2 y e
5 Location (0 Port Number Range
B8 Authorzation Code (0) Minimum &7 = Meximum 50750 s
3 w2 POSPEXP
Port Number Range (NAT)
Minsmum &70 = Maximum 3750 >
4] Ensble RTCP Morstoning on Port 5005
FTCP collector IP sddress for phones
Keepalives
cope RTP-RICP v Paniedi imesout 30
nial keepalves Enabled <
< >
ox Cancel Help
QT; Reviewed: Solution & Interoperability Test Lab Application Notes 7 of 27
SPOC 10/11/2016 ©2016 Avaya Inc. All Rights Reserved. IMTTLSIPO10




On the Network Topology tab in the Details Pane, configure the following parameters:

e Select the Firewall/NAT Type from the pull-down menu that matches the network
configuration. No firewall or network address translation (NAT) device was used in the
compliance test as shown in Figure 1, so the parameter was set to Open Internet. With this
configuration, STUN will not be used.

e Set Binding Refresh Time (seconds) to 60. This value is used as one input to determine the
frequency at which IP Office will send SIP OPTIONS messages to the service provider.

e Set Public IP Address to the IP address of IP Office WAN port. Public Port is set to 5060
for UDP and TCP, and 5061 for TLS.

e All other parameters should be set according to customer requirements.

e Click OK.

Configuration || ¥ SEQTVM"* B9 (X v <>

=R BOOTP (8)
-4 Operator (3)
i---’-;-Sqution System LAN1 LANZ  DNS Voicemail Telephony Directory Services  System Events  SMTP SMDR VolP VolP Security
+-§  User(30)
+1§ Group(1)

Contact Center

LAN Settings VolP  Metwork Topology

+-9% Short Code(45) MNetwork Topology Discovery 2
STUN Server Address STUN Port 3478 =
i Accou.nt Code(0) Firewall/NAT Type Open Internet ~
T---ﬁ‘, User Rights(9)
i &5 Location(0) Binding Refresh Time (sec) 60 =
=I-%=p SEQT VM
= Public IP Address 10 0 97 61 Run STUN Cancel
: X Public Port
+-<2 Control Unit (8)
i Extension (6) upP 3060 =
+§ User (7) =
..... .,a Group (0) TCP 5060 -
+-@% Short Code (50) =
= @ Service (0) TLS 5061 2
+-§P) Incoming Call Route
: e - g ( [] Run STUN on startup v
7 Time Profile (0) a 5
-l P Route (1)
Bl Account Code (0)
B License (30) 0K Cancel Help
N WP

In the compliance test, the LANL1 interface was used to connect Avaya IP Office to the enterprise site
IP network. The LANL1 interface configuration is not directly relevant to the interface with service
provider SIP Trunking service, and therefore is not described in these Application Notes.
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5.2. System Telephony Settings
Navigate to the Telephony - Telephony Tab in the Details Pane.

Choose the Companding Law typical for the enterprise location.

Uncheck the Inhibit Off-Switch Forward/Transfer box to allow call forwarding and call

transfer to the PSTN via the service provider across the SIP trunk.

Uncheck the Drop External Only Impromptu Conference box to allow the host of 3 way

conference leaving the active call without forcing all the parties off the conference.

[ ]

e For North America, U-LAW is used.
[ ]

[ ]

e Other parameters are left at default.
e Click OK.

_ ;

[

i IPO P EXP

Time Profile (0)
v P Rowe (1)
&9 Account Code (0)
e Lcensa (30
‘ ‘. Uses Rights (9)
i ¢ ARS(1)
& Location (0)
{8 Authorization Cede (0

] Enforcement

SEQTVM

Logn Code Complextty

RTCP Collecter Conligunmtion

[C] Servd RTCP to an RTCP Collector

v

3 T4 ) o sRID ¢ " -
R E“m’p =) Systems  LANT  LAN2  DNS  Voemall Telephony Dicectory Services Spstom Events SMTP  SMDR Vol VolIP Security  Ceetact Center
415 Cperator (3) >
“¥ Soluticn Telephory  Park & Page Tones & Music Ring Tomes  SM Callteg TUI
i User30
+- Nl Group(l) Dial Debay Time (zes) 4 s Cempanding Law
& B Short Codef45) Swtch Line
= Directory(d) Dial Defary Conrnt -
1 Tene Profiledd) -
8. Account Codell) Defaut No Answes Time [sec) 15 3 & U-Low @ U-LawLine
s User Ricktsi®) =
83 Ver s3] Hold Timeout {sec) 120
S Location(d) a
e SEQT WM Park Timecwt (sec) 300 % o St
W System (1)
o SEQT V™ Fing Delay (sec) 1
T Line (2 ] DSS Status
Control Unit (8) Cail Pricuity Prometion Time (sec) Disabled 2.
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5.3. VOIP Security Settings

When enabling SRTP on the system, the recommended setting is Preferred. In this scenario, IP
Office uses SRTP if supported by the other end, and otherwise uses RTP. If the Enforced setting is
used, and SRTP is not supported by the other end, the call is not established.

Individual SIP lines and extensions have media security settings that can override system level
settings. This can be used for special cases where the trunk or extension setting must be different
from the system settings.

In the compliance testing, Preferred is set at system, trunk and extensions level to allow the system
to fall back to none-security media in case there is issue with SRTP. This would help to avoid
blackout situation within the enterprise network. In some specific deployment, if supported, Enforce
is set at trunk level to ensure the secured communication over the public internet using both
signaling (TLS) and media (SRTP). Navigate to System = VoIP Security tab and configure as
follow:

e Select Preferred for Media Security. The system attempts to use secure media first and if

unsuccessful, falls back to non-secure media within Avaya IP Office system.
e Other parameters are left as default.
e Click OK.

N

Configuration |:: SEQTVM i v o s 2

- K poOTP (8

: System LANT  LANZ  DNS Voicemail Telephony Directory Services  System Events SMTP  SMDR  VelP
#-¢# Operator (3)

VolIP Security  Contact Center

;---’-j;- Selution
+-§  User(30) ~
+ﬂ Group(1) Media Preferred ~ [] Strict SIPS
+-B% Short Code(43)
~-a¥s Directory(0)
----- 17 Time Profile(0)
""" &3 Account Code(D) Media Security Options
B
48 Lo ighet Encrvotions o
=15 SEQT VM [ rrcp
:ffstseggrpim Authentication RTP
H-F7 Line (2) RTCP
+ = Control Unit (3) Replay Protection
¥4 Edension (6) SRTP Window Size [64
= User (7)
ﬂ Group (0) Crypto Suites
+-@% Short Code (30) SRTP_AES_CM_128_SHA1_80
B Service (D) SRTP_AES_Ch_128 SHAT 32
: e Inceming Call Rou
@ Directory (0) W
Time Profile (0]
o-Jill IP Route (1) -
- Account Code (0] =P
QT; Reviewed: Solution & Interoperability Test Lab Application Notes 10 of 27

SPOC 10/11/2016 ©2016 Avaya Inc. All Rights Reserved. IMTTLSIPO10



5.4. Administer SIP Line

A SIP line is needed to establish the SIP connection between IP Office and Intermedia SIP Trunking
service. The recommended method for configuring a SIP Line is to use the template associated with
these Application Notes. The template is an .xml file that can be used by IP Office Manager to
create a SIP Line. Follow the steps in Section 5.4.1 to create the SIP Line from the template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:
e |P addresses.
SIP Credentials (if applicable).
SIP URI entries.
Setting of the Use Network Topology Info field on the Transport tab.

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary after
the SIP Line is created via the template. The resulting SIP Line data can be verified against the
manual configuration shown in Section 5.4.2.

Also, the following SIP Line settings are not supported on Basic Edition:
e SIP Line — Originator number for forwarded and twinning calls.
e Transport — Second Explicit DNS Server.
e SIP Credentials — Registration Required.

Alternatively, a SIP Line can be created manually. To do so right-click Line in the Navigation Pane
and select New = SIP Line (not shown), then follow the steps outlined in Sections 5.4.2.

5.4.1. Create SIP line from Template

1. Copy the template file to the computer where IP Office Manager is installed. Rename the
template file to AF-IMT-SIPTrunk-1PO10-TLS.xml. The file name is important in
locating the proper template file in Step 4. The content of this template file can also be
found in the Appendix Section of this document.

2. Import the template into IP Office Manager.
From IP Office Manager, select Tools = Import Templates in Manager. This action will
copy the template file into the IP Office template directory. The default template location is
C:\Program Files\Avaya\lP Office\Manager\Templates.

" Avaya |IP Office Manager for Server Edition SEQT VM [10.0.0.0.0 build 550]

File Edlit View Tools | Help
~] |1 Extension Renumber...
SEQT VM Export > o
s 2 Server Edition Service User Management
Configurati SIP Line - Line 19
p Busy on Held Validation ) o avr sz e
i & BOOTP (8) recdentials S5IP Advanced Engineenng
tlioger Operator (3) MSN Configuration
% Solution Print Buttan Label 19 -
o-@  User(30) -
+ R Group(l) Import Templates in Manager ‘ ,avaya!ab.con\
WX Short Code License Migration
- Directory(0) T Sy —— l
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In the pop-up window that appears (not shown), select the directory where the template file
was copied in Step 1. After the import is complete, a final import status pop-up window will
appear (not shown) stating success or failure. Then click OK (not shown) to continue. If
preferred, this step may be skipped if the template file is copied directly to the IP Office

template directory.

3. To create the SIP Trunk from the template, right-click on Line in the Navigation Pane, then
navigate to New - New from Template - Open from file.
Configuration | = : ~ SIP Line - Line 19
i+ & BOOTP (8) SIP Line Transport SIP URI ValpP SIP Credentials SIP Advanced Engineering
41 ¢ Operator (3)
=18y Solution Line Number 19 z
4@ User(30)
SR Group(1) ITSP Domain Name |avayalub.~.un‘u |
(i 9% Short Code (45)
“m Directory(0) Local Domain Name | l
40 Time Profile(0)
am Account Code(0) URI Type siP
v E‘; 8;5;5;?:::;)(% Location Cloud ~
FELoT e -
T '4" \ % Cut Ctrle X | |
Bl [ o |
s : ff;;' 7< Dalete CtrlsDel 3 |
m SIUU ' Validate I
) g ;::::r:l New from Template v Open from file [.
i 4D Incod Export as Template ;
-ﬂf. gvucct:)‘ny:@"':‘ “““““ "I" CrESTTrIPTIoT | I
4. On Open pop-up windows, Navigate to Manager - Templates, make sure Template File
(.xml) is the file type selected. Then select the file “AF-IMT-SIPTrunk-1PO10-TLS.xml”.
Click Open and OK (not shown).
" Open x
- 4 « Avaya > IP Office >  Manager © manager_files > template ¢ ch pl =]
Organize New folder :‘:SE > M O
o Quick access " Name es-MX P =
I Desktop fr-FR h
IPSET-UNISTIM-C7M
.:l, Downloads e
|| Documents LVMGreeting
&=| Pictures manager_tiles
How to commat MemoryCards
IPO10SBCET ni-NL
IPO10SBCET1 Phoneimages
template pt-BR
fu-RU
@ Desktop Templates
@ OneDrive V3 2 999
& Quang zh-Hans
[ This PC "
File pame: - | Template Files (*xml) ~
5. Once the SIP Line is created, verify the configuration of the SIP Line with the configuration
shown in Section 5.4.2.
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5.4.2. Create SIP Line Manually

To create a SIP line, begin by navigating to Line in the left Navigation Pane, then right-click in the
Group Pane and select New - SIP Line (not shown).

On the SIP Line tab in the Details Pane, configure the parameters as shown below:
To create a SIP line, begin by navigating to Line in the left Navigation Pane, then right-click in the
Group Pane and select New - SIP Line (not shown). On the SIP Line tab in the Details Pane,
configure the parameters as shown below:

e Set ITSP Domain Name to the enterprise domain so that IP Office uses this domain as the

host portion of SIP URI in SIP headers such as the From header.

e Check the In Service box.
Check the Check OOS box. With this option selected, IP Office will use the SIP OPTIONS
method to periodically check the SIP Line.
Incoming Supervised REFER is set to Never as Intermedia does not support REFER.
Outgoing Supervised REFER is set to Never as Intermedia does not support REFER.
Other parameters are set as default values.
Click OK.

Configuration | i= SIP Line - Line 2 e - K| v <>

+’$ BOOTP () # | 5IP Line Transport SIP URI VolP  SIP Credentials SIP Advanced Engineering
+-{# Operator (3)
=% Solution 2 = In Service

=g User (30)

+1ﬂ Group(1) lame |inter0p-ex.“com | Check 005

+-B% Short Code (45)
..... @ Directory(0) Name | |
----- {7 Time Profile(0)
----- Bl Account Code(0)
+§| User Rights(9) Cloud e Refresh Method Auto ~
[ Location(0)

Sip o Session Timers

arvm Timer (sec) On Demand 2
' Systemn (1)

- sy SEQT VM
=17 Line (3) |
..... ., 1

$1- Control Unit (£ | ™™ [
+$ Extension (6) |
_g User (7)
..... i NoUser Systermn Default i

Redirect and Transfer

Incoming Supervised REFER Mever ~

Outgoing Supervised REFER MNever ~
..... §~ 2552 H3z3- Send 302 Moved Temporarily O
""" £ 2555 5IPs-: Outgoing Blind REFER O

4B Service (0) Help
- £
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Select the Transport tab.

e The ITSP Proxy Address is set to IP Address of service provider. As shown in Figure 1,
this IP Address is shown in capture below.
e Inthe Network Configuration area, TLS is selected as the Layer 4 Protocol, and the Send
Port is set to the port number of service provider.
e The Use Network Topology Info parameter is set to LAN 2. This associates the SIP Line
with the parameters in the System - LAN2 - Network Topology tab.

e Other parameters retain default values in the screen below.

e Click OK.
Configuration | g SIP Line - Line 2* s < | >
+a BOOTP (8] * | SIP Line Transport SIP URI VolP  SIP Credentials SIP Advanced Engineering
H-4% Operator (3) ~
=57 Solution ITSP Proxy Address |64.28.122.44 |
-§  User (30)
+-5af Group(1) ) ;
-8 Short Code (45) MNetwork Configuration
a8 [Directory(0) Layer 4 Protocol TLS b Send Port 3061 =
----- 7 Time Profile(0) —
----- #m Account Code(0) Use Network Tepology Info | LAN 2 ~ 5061 =
+-§5 User Rights(3)
-8 Location(0) Explicit DNS Server(s) 0 0 0 0o || o 0 0
=I5 SEQT VM
) Calls Route via Registrar
Separate Registrar | v
= >
+-=» Control Unit (¢
+--4 Extension (6) QK Cancel Help

= = User (7)

Note: The TLS port is set to 5061 by default, but Intermedia would like customers to use port

6061 for trunk connectivity.
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A SIP Credentials entry must be created for SIP TLS registration and authentication used by service
provider to authenticate calls from the enterprise to the PSTN. To create a SIP Credentials entry, first
select the SIP Credentials tab. Click the Add button and the New Channel area will appear at the
bottom of the pane. To edit an existing entry, click an entry in the list at the top, and click the Edit...
button. In the bottom of the screen, the Edit Channel area will be opened. In the example screen
below, a previously configured entry is edited. The entry was created with the parameters shown
below:

e Set User name, Authentication Name and Contact to the value provided by the service
provider.

e Set Password and Confirmed Password to the value provided by the service provider.

e The Expiration (mins) is set to 10.

e Check the Registration required option. Service provider requires registration and
authentication.

e Click OK.

Configuration ‘ T SIP Line - Line 2 ek - v |<|>

r---a BOOTP (3) ~ | SIP Line Transport SIP URI VolP  SIP Credentials S|P Advanced Engineering
+-i% Operator (3) — — - - N
=55 Selution Index  User Name Authentication Mame Contact Expiration (mins) Register Add...

w-§  User (30)

-5 Group()

+-@% Shart Code (43)
----- @5 Directory(0)
£ Time Profile(0)
----- Bl Account Code(0)
+§»' User Rights(9) Edit 5IP Credentials

i~ Location(D) User name |dgwsim

Remove

Edit...

QK

-5 SEQT VM
5= System (1) Authentication Name |d9W5i_

Cancel

|

- |
i 3y SEQT VM

i'"T'_‘. Line (3) Contact | |

|

|

..... w1

_____ w2 Password |nnnunon"

Confirm Password ssssssssssssnes

#-“2 Control Unit (8)
+® Extension (6) Expiration (mins) 10 =
3§ User(n)

""" : MNoUser Registration required W
----- § 2550 H323-255(
----- § 2551 H323-255

..... $im 2557 11373,0550

Help

A SIP URI entry Channel 1 is created to match incoming numbers that IP Office will accept on this
line. Select the SIP URI tab, click Add button and then New Channel area will appear at the bottom
of the pane. To edit an existing entry, click an entry in the list at the top, and click the Edit... button.
In the example screen below, a previously configured entry is edited. For the compliance test, a
single SIP URI entry was created that matched any DID number assigned to an IP Office user. The
entry was created with the parameters shown below:

e Set Local URI, Contact and Display Name to Use Internal Data. This setting allows calls
on this line which SIP URI matches the number set in the SIP tab of any User as shown in
Section 5.7.

Set Identity to None and Header to P Asserted ID for Identity.
Set Sent Caller ID to P Asserted ID for Forward and Twinning.
Set Diversion Header to None.

For Registration, select the account credentials previously configured on the line's SIP
Credentials tab.
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e Associate this line with an incoming line group in the Incoming Group field. This line
group number will be used in defining incoming call routes for this line. Similarly, associate
the line to an outgoing line group using the Outgoing Group field. For the compliance test, a
new incoming and outgoing group 2 was defined that only contains this line (line 2).

e Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed using
this SIP URI pattern.

e Other parameters retain default values and or set according customer requirements.

e Click OK.

SIP Entry Channel 1 is shown below.

Configuration ‘ i SIP Line - Line 2 ef - v | <>
BOOTP (2) SIP Line Transport SIP URI YoIP  SIP Credentials SIP Advanced Engineering
{+ Operator (3)
%20 Solution URl Groups Local URI  Contact Display Mame Identity Header Originator Number 5end Caller ID Diver .
af User (30) 1 22  <ntemal> <Intemal> <Internal>  None  PAl PAI Nong
EJ-"H Group(1) Remove
8% Short Code (45)
----- a5 Directory(0) Edit
----- £ Time Profile(0)
----- Bl Account Code(0)
-fy User Rights(9)
""" i Location(0)
-5 SEQT VM
- .
Edit URI 0K
Local URI |U5e|nterna| Data v|
Cancel
Contact |U5e|nterna| Data v|
-2 Control Unit (&) Display Name |U5e Internal Data v|
-4 Extension (6) Identity
B-§  User (7)
----- u Group (D) Identity |N0ne v|
(- 9% Short Code (50)
_____ @ Service (0) Header P Asserted ID ~
E]---@ Inceming Call Route ( ) o
..... @ Directory (0) Forwarding And Twinning
L1 Time Profile (0) Originator
&l IP Route (1) Number
----- @ Account Code (0)
..... % License (30) Send Caller ID P Accerted ID -
i-§i3 User Rights (3)
(- ARS (1)
""" & Location (0)
----- 8 Authorization Code (0 o
- |PO SP EXP Diversion Header |N0ne I
Registration 1: dgwsioN. ~
Incoming Group
Max Sessions 10 = w
Help

Select the VoI P tab to set the VVoice over Internet Protocol parameters of the SIP line. Set the
parameters as shown below:

e The Codec Selection can be selected by choosing Custom from the pull-down menu,
allowing an explicit ordered list of codecs to be specified.

e Selecting G.711 ULAW and G.729 codec supported by the Intermedia Trunking service, in
the Session Description Protocol (SDP) offer.
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e Set Fax Transport Support to G.711 from the pull-down menu (T.38 faxing is not currently
supported by Intermedia).
e Set the DTMF Support field to RFC2833/RFC4733 from the pull-down menu. This directs
IP Office to send DTMF tones using RTP events messages as defined in RFC2833.
e Check the Re-invite Supported box.
e Check the PRACK/100rel Supported box.
e Media Security is set to Enforced and check the RTCP checkbox in the Advanced Media
Security Options.
e Default values may be used for all other parameters.
e Click OK.
Configuration | T SIP Line - Line 2 ek - v <>
=K BOOTP (8) SIP Line Transport SIP URI VoIP SIP Credentials SIP Advanced Engineering
Sﬁjﬁﬁﬂ' e [ Local Hold Music ~

F-§  User (30)

-5 Group(1)

[-8% Short Code (45)
----- 2 Directory(0)

i Time Profile(0)
----- #m Account Code(0)
[-f User Rights(G)

""" @ Location(D)
£ SEQT VM

t-<2r Control Unit (
H-48 Extension (6)

Selection

Custom

Unused

G711 ALAW 64K
G.722 64K

Selected

G711 ULAW 64K
(G.72%(a) BK C5-ACELP

Re-invite Supported
[ Codec Lockdown
[ Allow Direct Media Path
Force direct media with phones

PRACK/100rel Supported

U% E:ELSJ(D] nsport support | G711 ~
U"'g zhmff C?g']e G support RFC2833/RFCATI3 v
----- ervice
UE g;:::;:}?(g;” Security Enforced v
[]:; ;E"EE ptm?]l]e {t Advanced Media Security Options [ same As System
oute
----- ) Account Code
----- % License (30) .
i-§ User Rights (9] Encryptions RTP
H-" ARS (1) RTCP
""" & Location (0)
. ﬁ)i:tgigzatim Authentication RTP
) RTCP
Replay Protection
SRTP Window Size |64
Crypto Suites
SRTP_AES_CM_128_SHA1_80
SRTP_AES_CM_128_SHA1_32 .
< >
Help
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5.5. Short Code

Define a short code to route outbound traffic to the SIP line. To create a short code, select Short
Code in the left Navigation Pane (not shown), then right-click in the Group Pane and select New
(not shown). On the Short Code tab in the Details Pane, configure the parameters for the new short
code to be created. The screen below shows the details of the previously administered “9N;” short
code used in the test configuration.

e Inthe Code field, enter the dial string which will trigger this short code, followed by a semi-
colon. In this case, 7N, this short code will be invoked when the user dials 7 followed by any
number.

e Set Feature to Dial. This is the action that the short code will perform.

e Set Telephone Number to the value shown in the capture bellow. This field is used to
construct the Request URI and To headers in the outgoing SIP INVITE message. The value
N represents the number dialed by the user. The host part following the “@” is the domain of
the service provider network.

e Setthe Line Group Id to the outgoing line group number defined on the SIP URI tab on the
SIP Line in Section 5.4. This short code will use this line group when placing the outbound
call.

e Others parameters are at default values.

e Click OK.

Configuration ‘ Short Code b 7N;: Dial* ek - X|wl<]>

R BOOTP () Code Telephone M || Short Code
Operator (3) [ eI | |
=7 Solution - Code TM:
----- § User(3D) ::f'
..... ﬂ Group(1) 43 Feature Dial ~
----- 8X Short Code(43) Bx-49 P : .
..... @i Directory(0) s Telephone Number |N @mterop—coml
{13 Time Profile(D) x .
----- = Accou.nt Code(D) ::*:12 Line Group ID |2 Vl
g E;:;E;g:z;(g) 53N N Locale United States (US English) ~
%59 SEQT VM @55 Force Account Code |
= System (1) P57NE N orce Authorization Code | !
9 Line (3) IHEENE N Force Authoriation Code ]
é Control Unit (8) BXTONE N
4@ Extension (6) T
§ User(m) “;1 N N )
2 Group (0) g0 edit_messa
X Short Code (50) | 6N N @interop-
B Service (0) TN, N"@interop-
) Incoming Call Rot | mwnn X N oK Cancel Help
am Directnn (0 < >
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For incoming calls from mobility extension to FNE features hosted by IP Office to provide Dial
Tone functionality, Short Code FNEOO was created. The FNEOO was configured with the following

parameters.

e Inthe Code field, enter the FNE feature code as FNEOQO for Dial Tone.

e Set the Feature field to FNE Service.

e Set the Telephone Number field to 00 for FNEOQO.
e Setthe Line Group ID field to 0.

e Retain default values for other fields.

e Click OK.
Configuration ‘ Short Code i= FNEOO: FNE Service e - x| v |«
R BOOTP (3) Code Telephone b || Short Code
# Operator (3) Px+4a
== ;muJionGD) x40 Code |FNEDD |
..... cer
..... .‘u Group(1) B350 Feature FME Service ~
----- 8% Short Code(43) %51
..... @ Directory(D) Bx+52 Telephone Number |CID |
ot Time Profile(0) Pa753NE N Line Group 1D |CI v|
----- Bl Account Code(0) *
§4 User Rights(9) 955
i User Rightsi . Locale o
""" & Location(0) “xS?rN# N
[=-5=3 SEQT VM PRGN N Force Account Code O
H_’ S:_’Gtem (1 D=70N# N Force Authorization Cede [
----- 19 Line (3) PATINE N
""" & E;ntrql Un;: @ ex *00, "edit_messar
..... a Us:rnél;n ® PUEN; N"@interop-
..... 2% Group (0) BATN: N"@interop-

----- 9% Short Code (50) | #% 9N M

----- @ serice

----- @ Inceming Call Rou ~ Help
----- = Directory (0] < z
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5.6. Extension

Assumption is that IP extensions (SIP and H.323) have already been created for users. Navigate to
Extension, select an (IP) Extension and then click on VolIP tab. Ensure the parameters are being set
as shown in capture.

et -4 X v « > §

R BOOTP (§) D Extemt| Egengion VoiP

i* Operator {3) ™, 11200 2555
=S Solution c —~ Enable Fastatant for

11201 2556 [ ) )
§ User3 - ‘UV ‘?i P Address 0 0 0 0 & non-fvays IP phanes

& Geoupll) 11208 25%7
$X Short Codedds) | ™ 11203 2550 MAC Address
. Directory(0) 11204 2550 T

1) Time Profile(0) |, 11208 2442 Codec Sedection System Defauit v L] Ll Tpnes
8w Accourst Codelt 7] Aiow Direct Mecka Path

4] Owt Of Band DTMVF

§ User Rights(9) = -
¥ Location(l) »>> u.‘-zl lu‘.ﬂ M(
W SECTWVM G711 ALAW 64K
= System (1) | G,729{a) 8K CS-ACELP
T% Line (3 ‘ G722 84K
Control Une
& Extenzion {6)
§ Ve
' Group (0)
9% Shoet Code (
Service {0)
Incoming Cz
= Directory ()
207 Tiene Profile
B P Route (1)
48 Account Cot Supplementary Services None
W License (30)
i . U;‘-‘s' Righta Media Security Sermve u3 Systern (Prefemmed)
ARS (1)
: L”‘:'"::" Advanced Media Securty Options £ Seme As System
Authorzato
i W POSP DR

<«

Reserve License Nene

Help
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5.7. User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP line
defined in Section 5.5. To configure these settings, first select User in the left Navigation Pane, then
select the name of the user to be modified in the center Group Pane. In the example below, the name
of the user is “H323-2551". Select the SIP tab in the Details Pane.

e The values entered for the SIP Name and Contact fields are used as the user part of the SIP
URI in the From header for outgoing SIP trunk calls. They also allow matching of the SIP
URI for incoming calls without having to enter this number as an explicit SIP URI for the
SIP line (Section 5.5). The example below shows the settings for user H323-2551. The SIP
Name and Contact are set to one of the DID numbers assigned to the enterprise from service
provider.

e The SIP Display Name (Alias) parameter can optionally be configured with a descriptive
name.

e If all calls involving this user and a SIP Line should be considered private, then the
Anonymous box may be checked to withhold the user’s information from the network.

e Click OK.

= H323-2661: 2661 - X v <« > @
User Voicemail DNO  Short Codes Source Numbers Telephony Forwarding Dislln  Voice Recording
Web Seli-Administration
Button Programming  Menu Programming  Mobdity Group Membership  Anncuncements SIP Personal Dwectory
SIP Nome "
SIP Display Name (Alias) |H323-2551
Contact 2066864543
L] Anonymous v
T{Line(3d)
Cantrol Uni Help
o Evpncnn (01 € >
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One of the H.323 IP Phones at the enterprise site uses the Mobile Twinning feature. The following
screen shows the Mobility tab for User H323-2551.

e The Mobility Features and Mobile Twinning boxes are checked.

e The Twinned Mobile Number field is configured with the number to dial to reach the
twinned mobile telephone, in this case 76139675205 including access code of 7.

e Other options can be set according to customer requirements.

e Click OK.

E

-2 X v i< > @

§ User Rights(9)
&% Location{D
o SEQT WM
= System (1)
T4 Unet3)
Control Uni |
& Edension (€|
i vem
R Group (1)
% Short Code
D serice ()
@ ncoming C|
= Dwectory (0]
Time Profile |
M ® Route (1)
&a Account Cc|
W License (30) |
B User Rights
¥ ARS (1)
& Location (0|
8 Authorizatic|
S0 POSPEXP

R 800TP (8 | Name Eatens |
= Operator (2) | §rH323-2550 2550
¥ Soluton | 237.7581 255
§ Ve |Bnasias
2 Geoup(l] “‘.-H.-.-]- 532 35352
9% Shot Code(4s; | fmMoUzes
o Drectory(D) | fnSIPS-2555 2555
Time Profile(D) | fn5IPS-2556 2556
am Account Codef : §rsips-2557 2557
|

User Voicemad DND  Short Codes Source Numbers Telephomy Forwarding Dialin  Voice Recording

Web Se¥-Admmistsation

Button Programmung  Menu Programmng  Mobdty  Group Membership  Announcements  SIP

] intemal Twinning

‘i’ Mobilty Features

(2] Mebite Twinnng

Twinned Mobée Number 16139675209
including dial access code)

Twinning Time Profile <Nooe>
Mobile Diad Delay (vec) 2

Mobile Answer Gusrd (sec] ©

[C] Hunt group calls eligible for mobile twinning

[} Forwarded calls eligible for mobile twinning

[Z] Twin When Logged Out
£ ene-X Mobile Chert
Ij Moebile Call Control

Motule Calllzack

Personal Directory
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5.8. Incoming Call Route

An incoming call route maps an inbound DID number on a specific line to an internal extension.
This procedure should be repeated for each DID number provided by the service provider. To create
an incoming call route, select Incoming Call Route in the left Navigation Pane, then right-click in
the center Group Pane and select New. On the Standard tab of the Details Pane, enter the
parameters as shown below:

e Set the Bearer Capacity to Any Voice.
e Setthe Line Group Id to the incoming line group of the SIP line defined in Section 5.5.
Set the Incoming Number to the incoming number on which this route should match.

°
e Set Locale to United State (US English).
e Default values can be used for all other fields.
e Click OK.

Configuration  Incoming CallR... | = 22066864943 e - X v

R soare @ | Line Group [0 Incoming M| Standard  Vaice Recording  Destmabions

* Operater 3) [Pz 2066360218 || "

W Sohution S ‘ ibl
‘ﬂ E:jnlln (@2 Bearer Capabilty Any Yoice
9% Short Codeld5) | i3 Line Group 10
. Directory(l) | @10 A g

':um Profile(®) ‘ Q 19 ncoming Number 2066554943

: '»."' Fl?‘:r:h: ::r.l' ' g(: Incoming Sub Address

5 Location(0

, Incoming Cl
v SEQT WM v

5 SySt I Locale United States (US Engleh)
T4 Line (3)
Control Unit (8} Priority 1+ Low
& Extension (8)
‘ L Tag
¢ G
9% Short Code {503 Hold Music Source System Source
@ Service (0) ’
') Incoming Call Route Ring Tone Overnde MNone
& Directory {0
Time Profile (J) Help

Bl D Depe (1) 1€ >

On the Destinations tab, select the destination extension from the pull-down menu of the
Destination field. In this example, incoming calls to Incoming Number on line 2 are routed to
extension 2551. Click OK.

Configuration | Incoming Call Route 2 2066864943 ef - X v <>
- Line Group ID Incoming Ni ™ || gtandard  Voice Recording Destinations
gi ig:::z;ig TimeProfile Destination Fallback Extension
@0 5012871499 » Default Value 2551 H323-2551 ~ ~
[T~ 3L 6132606508
fam 111111111 - e Help
Error List SEQT VM v

5.9. Save Configuration

Navigate to File = Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.
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6. Intermedia Networks SIP Trunking Configuration

Intermedia is responsible for the configuration of Intermedia SIP Trunking service. The customer
will need to provide the IP address used to reach the Avaya IP Office at the enterprise. Intermedia
will provide the customer the necessary information to configure the Avaya IP Office SIP
connection to Intermedia. The provided information from Intermedia includes:

IP address of the Intermedia SIP proxy.

Supported codecs.

DID numbers.

IP addresses and port numbers used for signaling or media through any security devices.

7. Verification Steps
The following steps may be used to verify the configuration:

e Use the Avaya IP Office System Status application to verify the state of the SIP connection.
Launch the application from Start = Programs => IP Office = System Status on the PC
where Avaya IP Office Manager was installed (not shown). Select the SIP line of interest
from the left pane. On the Status tab in the right pane, verify that the Current State is Idle
for each channel (assuming no active calls at present time).

AVAYA IP Office System Status

Help Snapshot LogOff Exit About

Status  Utilization Summary Alarms  Registration
SIP Trunk Summary ~
Line Service State: In Service
Peer Domain Mame: interop-ex.zea.accessline, com
Resolved Address: 192.168.122.44
Line Mumber: 2
Number of Administered Channels: 10
Number of Channels in Use: 0
Administered Compression: G711 Mu, GT29 A
Enable Faststart: off
Silence Suppression: off
Media Stream: SRTP
Layer 4 Protocol: TLS
SIP Trunk Channel Licenses: 128 . -
o
SIP Trunk Channel Licenses in Use: a
SIP Device Features: UPDATE (Incoming and COutgoing)
Channel U... Call Current Timein Remote Co... Conn... Caller Other Party Directi... Round Receive Receive Trans... Trans...
MNumber ief State  State  Media... IDor ... onCal Trip... Jitter Pack...
1 dle [01:30... Codec ~
2 Idle |0L:46...
3 Idle |01:45... v
Trace Trace Al Pause Ping Call Details Graceful Shutdown Force Out of Service Print...
Save As...
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e Select the Alarms tab and verify that no alarms are active on the SIP line.

AVAyA IP Office System Status

Status  Utilization Summary Alarms Reqgistration

Alarms for Line: 2 SIP interop-ex.sea.accessline.com

Last Date Of Error Qcourrences Error Description

Clear Clear all Graceful Shutdown Force Out of Service Print... Save As...

Online

e Verify that a phone connected to PSTN can successfully place a call to the Avaya IP Office
with two-way audio.

e Verify that a phone connected to Avaya IP Office can successfully place a call to the PSTN
with two-way audio.

e Using a network sniffing tool e.g. Wireshark to monitor the SIP signaling between the

enterprise and service provider. The sniffer traces are captured at the LAN2 of the Avaya IP
Office.

8. Conclusion

The Intermedia SIP Trunking passed compliance testing. These Application Notes describe the
procedures required to configure the SIP connection between Avaya IP Office and the Intermedia
SIP Trunking service as shown in Figure 1. All feature and serviceability test cases were completed
successfully with observations noted in Section 2.2.
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9. Additional References

[1] Administering Avaya IP Office Platform with Manager, Release 10.0, August 2016.

[2] Avaya IP Office™ Platform Server Edition Reference Configuration, Release 10.0, Issue 04.AD,
August 2016.

[3] Deploying IP Office™ Platform Server Edition Solution, Release 10.0, August 2016.

[4] IP Office™ Platform, Using a Voicemail Pro IP Office Mode Mailbox, Issue 10D, May 2016.

[5] Using Avaya Communicator for Web, Release 1, Issue 1.0.6, May 2016.

Additional Avaya IP Office information can be found at:
[6] http://marketingtools.avaya.com/knowledgebase/ipoffice/general/rss2html.php? XMLFILE=manuals.
XmI&TEMPLATE=pdf_feed_template.html

Product documentation for Avaya products may be found at http://support.avaya.com. Additional IP
Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/

Product documentation for Intermedia SIP Trunking is available from Intermedia Networks.
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Avaya and the Avaya Logo are trademarks of Avaya Inc. All trademarks identified by ® and ™
are registered trademarks or trademarks, respectively, of Avaya Inc. All other trademarks are the
property of their respective owners. The information provided in these Application Notes is
subject to change without notice. The configurations, technical data, and recommendations
provided in these Application Notes are believed to be accurate and dependable, but are
presented without express or implied warranty. Users are responsible for their application of any
products specified in these Application Notes.

Please e-mail any questions or comments pertaining to these Application Notes along with the
full title name and filename, located in the lower right corner, directly to the Avaya DevConnect
Program at devconnect@avaya.com.
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